
Issue Number: GAME30

Why choose Demon Internet -- 30-day Free Trial.
This offer includes a free 30 day dial-up account with Demon Internet, and free 30 day use of 
Demon's Internet Suite.  Demon Internet is the UK's largest and most experienced Internet 
Service Provider. This British owned company is the pioneer of low-cost Internet access and 
is constantly improving and growing its infrastructure and systems to satisfy the demand for 
inexpensive Internet access.

Once you've chosen your email name you can send and receive as much Email as you want 
and access all the different News discussion groups. There are no extra surcharges or on-line
costs.

Demon Internet provides local call access to the Internet for the whole of the UK. So you can 
access the Internet anywhere in the UK for the cost of a local call, keeping phone costs to a 
minimum.

If you do need some extra help, Demon offers free 24 hour telephone support, 7 days a week.

After the free 30 days, for a £12.50+VAT sign-on fee, and a fixed monthly fee of £10+VAT you
have unlimited access with no hidden extras to Demon's network of multiple high speed 
international links and powerful servers for Email, News and the Web. What's more, we'll also 
give you 5Mb of Web space free, so you can make your own global impression on the World 
Wide Web.

How to get your Free 30 Day dial-up account set up.

To set up your Free 30 Day dial-up account phone our Call Centre on 0181 371 1234. You 
can call anytime, we are open 24 hours a day, 7 days a week. You'll just need to answer a few
simple questions to open your account. It's as simple as that.

It's important to have the following information to hand when you contact the Call Centre to 
set up your account:

    o this Issue Number: GAME30
    o Full Name               
    o Company Name  (if applicable)
    o Address                 
    o Post code               .
       
    o Daytime phone number
    o Evening phone number

    o Your choice of "host name" for your computer

This will give you an email address of the form username@hostname.demon.co.uk. 
The .demon.co.uk part of this address is fixed for standard dial up accounts.  (So if you
chose sixes-and-sevens as your "host name", then all your email addresses would be 
of the form username@sixes-and-sevens.demon.co.uk

Note - You can have as many usernames as you wish, either for yourself or other 
members of your family or your organisation. You don't need to tell Demon Internet 
what usernames you intend to use.

The hostname needs to be between 4 and 16 characters long. You can use a mixture 



of lower case letters, hyphens and digits, but you must start with a letter and you 
mustn't end with a hyphen or have two hyphens together.

It's a good idea to choose three or four hostnames that you like, in case someone is 
already using the first one(s) you think of.

    o a 'Security Phrase'

This will be used to identify you so that Demon Internet can make changes to your account 
over the telephone, secure in the knowledge that we are speaking to the account holder. We 
recommend that you don't tell other people your security phrase as it will be used as proof of 
identity.

    o Credit Card Number and Expiry Date (Access, Mastercard or Visa)
(and Card-holder address, if that isn't the same as the address above)

Don't worry, we will not take any payment from your credit card before your Free 30 
day period has expired. If before your Free 30 day period expires you decide you do 
not wish to proceed, then simply contact our sales team on 0181 371 1234 and we will 
close your account. You will need to give us at least seven days notice before the end 
of your free 30 days. You will not have paid Demon Internet anything. 

If you don't have a credit card then you can still apply for a Free 30 Day Trail Account 
by calling the sales team and asking them to send you an information pack. This will 
include alternative payment methods such as direct debit or cheque.

Installing and Using the Evaluation Software.
If you are going to take advantage of the 30-day free trial of the Demon service, then you 
should apply for that first -- see above.

With this free evaluation software and a dial-up Internet connection, you can send and 
receive email and news and use other on-line features for 30 days.

This Evaluation version is to a great extent just like the full Turnpike software. Indeed it only 
differs from the full software in the following ways:
* The system can only be used to dial up your Access provider for 30 days.
* You can't export news articles from this version.
* You can't re-import mail you've exported.
* It will automatically add a single line to each mail message or news article you write, telling 
the recipient how to get more information about Turnpike.

This document explains how to get up and running on the Internet using this Evaluation copy, 
and how to find out about the different facilities Turnpike offers. It also explains what to do 
when this Evaluation copy 'expires', either to convert to the full version of Turnpike or, if you 
don't want to continue using Turnpike, to export any mail you've sent or received using 
Turnpike in a format that can be read by other Mail readers.

New Users are also recommended to study the FYI28.WRI document provided alongside this 
README.WRI file. This explains the basic rules of 'Netiquette' (Network Etiquette) that all 
users are expected to follow.

(The READW95.DOC document that's also supplied alongside this README.WRI file offers 
advice for Windows 95 users on running Turnpike alongside the Windows 95 Dial Up 
Networking (DUN) software. It can be read using either Word 6 or the Windows 95 WordPad. 
However, there's no need to use the Windows 95 DUN unless you particularly want to as 
Turnpike provides its own Winsock which is both easier to set up and easy to use than the 
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Windows 95 DUN - as we shall describe below.) 

Getting going

The first time you are offered this 'Read me', you will have just started the Turnpike Setup 
program.  It will create either a 'Turnpike' program group or a Turnpike folder, containing icons
for three programs - Turnpike, Connect and Microsoft Internet Explorer, some 'Readme' 
documents (including this one, for future reference) and an 'Uninstall' program.

* Turnpike is the 'Off-line' program, used to read and prepare email messages and news 
articles.

* Connect is the 'On-line' program, used to dial up your Access provider, to transfer mail and 
news, and to use FTP, Telnet, Finger, Ping and other 'on-line services' (through Turnpike's 
Winsock).

* Microsoft Internet Explorer is used with Connect to 'browse' the World Wide Web.

Note: The version of Internet Explorer that is installed depends on the version of Windows 
you use. In particular, if you use Windows 95 or Windows NT 4.0 you will have been given 
Internet Explorer 3.0, but if you use Windows 3.x or Windows NT 3.51, you will have been 
given Internet Explorer 2.1 (because Internet Explorer 3.0 doesn't work with these versions). 
If you are using the Windows NT 4.0 beta, you will have been given Internet Explorer 3.0 but 
you will need to upgrade to the full NT 4.0 in order to use this.

Note, too, that the security features of Internet Explorer 3.0 are set to Microsoft's standard 
defaults. Among other things, this means that it is supplied with ActiveX and Java enabled. 
Depending on the sites you plan to visit, you may wish to disable these. For guidance, call up 
Internet Explorer's on-screen Help and search for information on 'Security'.

(In case you are worried, the 'bug' in early versions of Internet Explorer 3.0 which affected 
browsing of password-protected sites is fixed in the version which is installed from this CD, as
is the loophole that was found in the virus protection procedures.)

Set up

You should attach your modem to your PC (if it is not already attached), and run the Setup 
program.  The process is then:

    1. The Setup program will install Turnpike and Internet Explorer.

    2. Next you will see a dialog asking which Winsock you will be using.

Turnpike can be used with a range of different Winsocks but is easiest to use with the 
NTS Winsock supplied with Turnpike because it allows you to run the Turnpike Connect
program and to go on-line in one smooth action. However, if you have another Winsock
that you particularly want to use, you can use that instead - though you should note 
that you may not then be able to use Turnpike to dial. (Alternatively, you can try out 
using Turnpike with different Winsocks by starting with one Winsock - say, the NTS 
Winsock - then switching to another Winsock later.)

The NTS Winsock supplied with Turnpike is selected by default in this dialog (assuming
you installed this), so to use this Winsock you just have to click OK. To use another 
Winsock that you have installed on your system, select this from the drop-down list 
associated with the New Selection slot - then click OK. Turnpike will then ensure that 
the Winsocks you select are named WINSOCK.DLL (16bit) and WSOCK32.DLL (32bit) 
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while any conflicting Winsock files are suitably renamed.

    3. If necessary your machine will be restarted.  You can veto this if you wish, but you are 
unlikely to be able to connect to the Internet until your machine has been restarted.

    4. The Connect program will now run for the first time, to complete the set up, and then to 
go on-line to pick up a list of the newsgroups your Access provider is able to offer you.  
If there's any mail waiting for you, this will be collected at the same time.

The first thing you will see is the 'Sign-on' dialog in which you need to sign on using 
your email name: ie. if your email address is fred@hostname.demon.co.uk, sign on 
as fred. Then below the sign-on name will be a slot for a password to use to protect 
your Turnpike files but you don't need to give one unless you want to. Indeed, leaving 
this slot blank is a positive advantage if you are going to be the sole user of the system 
because you can then configure Turnpike to by-pass this sign-on dialog in future. (For 
further advice, press F1 to call up Turnpike's on-screen Help.)

You will then see a message advising you of the dates on which the Turnpike and the 
Connect programs you've installed will 'expire'. (This message will in fact appear as a 
reminder each time you run either Connect or the main Turnpike program.)

Then you will be offered a list of Access providers from which you need to pick your 
Access provider, then answer a short sequence of questions about the account you 
have with this Access provider.  If you are taking advantage of the free 30-day trial of 
Demon, then you should here choose Demon Internet.

If you will be using Turnpike to dial, you will then be offered a list of supported modems 
from which to pick out your modem - or at least one that is similar to yours. If you are 
uncertain which to pick, click the Help button shown alongside the list and follow the 
advice given there. Then when the 'Dial Settings' dialog appears, check the dialling 
information given (in particular, the Point of Presence that's selected); enter any 
additional codes that will need to be sent (eg. from a PABX); and set the modem port 
and the modem speed. (Again, click the Help button for advice on what to set.)

When you 'save' these settings, then assuming you're using Turnpike to dial, Turnpike will first
ask for your full name, then display its 'Connect' dialog for you to go ahead and connect to 
your Access provider. Simply click the Connect button to do this. (If Turnpike isn't being used 
to dial, you will instead see a message about a 'Third-party Winsock'. Leave this message on 
the screen while you dial up using whatever software you've been using to do this up to now, 
then promptly switch back to the Turnpike Connect program and allow it to continue.)

Messages on the Status bar at the bottom of the display will show Turnpike collecting news 
(in this case, the list of newsgroups) and picking up any mail that's waiting for you.

Collecting the list of newsgroups takes a little while, so while this is going on we suggest you 
click the Ping button on the toolbar. This displays the Ping dialog ready set up to 'Ping' your 
Access provider. Pinging provides a good way of checking that all is well, so we suggest you 
try this.

When Turnpike tells you News collection closed, you can disconnect from your Access 
provider (by clicking the Disconnect button) because Turnpike has now downloaded all the 
information it is going to take. But don't leave Turnpike Connect until the separate News 
completed - xxxx articles fetched and filed message has appeared, signalling that 
Turnpike has finished filing this information.

We now recommend that you use the main Turnpike program - to set up one or more 
'newsstands' for the Usenet newsgroups you want to follow, and prepare any mail messages 
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you want to send. If Turnpike Connect is still running, you can run the main Turnpike program 
by clicking the Mail/News button on the toolbar. Alternatively, you can return to the Turnpike 
program group / folder and double-click on the Turnpike program icon. (Give the same sign-
on name and password as you did when you ran the Connect program.)

When the program has loaded ...

* Read any mail that has arrived for you

If any mail has arrived for you, the 'Mailbox' icon at the bottom of the Turnpike display will be 
showing a little pile of papers in its top tray and flashing.

To see this mail, double-click on the Mailbox icon to go into your mailbox. The messages that 
have arrived will then be listed in the upper part of the mailbox display. To read a message, 
double-click on it to open it - then when you've finished reading it, close it and open another.

Note: Each message actually starts with a 'Header' comprising several lines of administration
information, but Turnpike normally limits what it displays to the subject, the author and the 
date. If you would like to see the full header on a message, take the Display Header option 
from the Options menu.

* Set up a 'newsstand' for your newsgroups

To do this, take the New newsstand option from the File menu. This displays a tabbed dialog 
with separate 'pages' for newsstand name, fonts etc. To start with, the Name page is selected.

There are several aspects of your newsstand that you can configure through this dialog, but 
such refinements can wait. For now, just type a suitable name for the newsstand in the Name 
slot, then click the OK button at the bottom of the dialog.

Turnpike then sets up a new newsstand for you. The main area of this newsstand is for a list 
of the newsgroups to be accessed through this newsstand. To record the newsgroups you 
want, click the Add button at the bottom of the newsstand display. This displays a further 
dialog - the 'Newsgroup addition' dialog - through which you select the newsgroups you want 
by selecting them one by one from the list in the upper part of the dialog and then 'Adding' 
them to a list in the bottom part. (For details of the steps to take, press F1 to call up the Help 
file when you have this dialog on the screen.)

New users of the Internet are recommended to subscribe to the news.announce.newusers 
newsgroup, while demon.ip.support.turnpike (if this is available to you) is the newsgroup to 
subscribe to to find out more about Turnpike. In particular, it carries an 'FAQ' covering various 
aspects of using Turnpike (re-posted every fortnight).  Alternatively, you can get a copy of this 
FAQ either by FTP (ftp://ftp.demon.co.uk/pub/mirrors/turnpike/turnpike.faq) or by sending
an email request to faq_request@turnpike.com.

When you've selected the newsgroups you want, click OK. You will then be returned to the 
newsstand, where you'll see the newsgroups you've selected listed in the order in which you 
picked them out. (If you would like the newsgroups in a different order, you can either use the 
Move Up and Move Down buttons to re-order them or simply drag newsgroups up or down 
the list until the newsgroups are in the order you would like.)

Articles from the newsgroups you've selected will be collected the next time you use Turnpike
Connect to connect to your Access provider.

* Prepare any email messages you want to send
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To prepare an email message, select your mailbox then click the Start new email button on 
the toolbar. (If you can't see your mailbox to select it, pick it out from the Windows menu.)

This calls up Turnpike's Editor ready for you to write your message. Simply fill in the email 
address of the person you want to write to in the 'To' slot; fill in the subject in the 'Subject' slot;
and type the text of your message in the section above the continuous line drawn across the 
display. (Note: There's no need to type a carriage return at the end of each line because 
Turnpike will automatically insert the required line breaks for you. There's also no need to 
worry about the number of characters per line as the margins are automatically set to give the
recommended maximum of 72 characters per line in the font you are using.)

What's shown below this line is a 'signature' based on your full name, which Turnpike has 
inserted for you. This is just text which you can change in any way you want simply by editing 
it. However, after setting up the signature you want, we recommend taking the Save 
signature as option from the Signature menu and saving this signature as standard.sig: 
then Turnpike will in future insert this signature in your messages instead of the basic one you
started with this time.

When you've finished preparing your message, click the Post button on the Editor toolbar and
confirm that you want to post this message. The message is then put into your Out tray, from 
where it will be sent out across the Internet the next time you connect to your Access 
provider.

Note: If, rather than send a new message, you want to send a reply to a message you've 
received, don't take the Start new email option but instead select the message you want to 
reply to (or open it on the screen) then click the Reply button. This too takes you into 
Turnpike's Editor, but by taking the Reply option you automatically get the 'To' and 'Subject' 
slots filled in with the appropriate information from the original message. You also get a 
properly marked up copy of the original message in your reply so that you can readily quote 
from this if you want. Simply cut out any bits of the original message you don't want to 
include, add what you want to say and then click the Post button to add this reply to the 
collection of messages in your Out tray.

Exploring the Web

To explore the World Wide Web from Turnpike, you need to run the Connect program, 
connect to your Access provider - then click the WWW button on the Connect program toolbar
to run Microsoft Internet Explorer. (The Connect program provides the connection to the 
Internet over which the Internet Explorer accesses the Web.)

This takes you to the 'Starting page'. This and other Web pages contain underlined items, 
which are links to other Web pages or facilities. To call up any of these pages, simply click on 
the appropriate item - in the same way as you might call up different pages of information 
from a Help file. 

The other way of calling up other pages is by entering the page's 'URL' in the Address slot at 
the top of the display. (If this slot isn't shown, call up the View menu and select Address 
Bar.)

What's shown in this slot is the URL of the Web page you are looking at. To go to a different 
page, simply edit the URL that's currently shown and press [Enter]. For example, if you want 
to call up the Lycos Internet Catalog, you can do this by replacing the current URL by the 
Lycos Catalog page URL (http://www.lycos.com/) and pressing [Enter]. (This Lycos page is 
actually quite a useful one to call up because it allows you to access information on a whole 
range of different subjects.)

Each page you call up is automatically added to a 'History' which the Internet Explorer 
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records to make it easy for you to go straight back to pages you called up earlier. Simply use 
the Arrow buttons at the top of the screen to go back and forth through these pages - or call 
up the File menu and pick the page you want from the lower part of this menu. (The More 
History option in this menu calls up a display of all the pages you've visited, including in 
previous sessions.)

Note: Each new Web page you call up can take a little while to display, particularly where it 
contains a number of graphics. If there's apparently no response for 120 seconds, Turnpike 
will automatically display a message asking whether you want it to continue trying to contact 
the source of the information. The idea of this message is to save you running up expensive 
phone bills when the remote computer you are dealing with is too busy to service your 
request at a reasonable speed. If you feel that this message appears too often, then the next 
time you connect to your Access provider, pause at the Connect dialog and set the 'Idle 
timeout' to a larger number of seconds - or disable the feature altogether by setting the Idle 
timeout to 0. You may still be cut off by your Access provider, but if that happens, you should 
be able to carry on from wherever you were working by selecting the Connect program and 
clicking the Connect button to dial up your Access provider again.

Other actions

This introduction has only scratched the surface of the facilities Turnpike has to offer.

You can, for example, set up mailboxes for different types of mail; give yourself a range of 
email names and signatures to use (and arrange that the appropriate ones are used by 
associating these with different mailboxes and newsstands); tag messages with their subject 
so that you can pull out all the correspondence you've exchanged on a particular subject etc. 
etc. There are special features for News such as marking discussion threads 'interesting' if 
you want these drawn to your attention or 'uninteresting' if you don't, and 'Kill rules' to help 
you avoid cluttering up your disk with articles you don't want to read. There are also special 
features for shared systems that allow certain types of mail to be processed by any of a group
of people.

Similarly, when you are connected to your Access provider, there are additional facilities like 
Telnet, FTP, Finger and Traceroute and further features of Microsoft Internet Explorer to 
investigate.

The way to find out about all these features is from the on-screen Help. Either press F1 to call
up the appropriate Help then click the Contents button to turn to its Contents page, or use 
the options offered in the Help menu. This will show you a list of the broad areas covered in 
the Help. Click on the area you are interested in to display a page of information on that, then 
work on through the information given. Alternatively, use the Index/Search option to call up 
pages on particular topics or, if there are [>>] and [<<] buttons at the top of the display, you 
can use these to 'browse' through a series of pages on related topics.

Note: Turnpike, Connect and Microsoft Internet Explorer are separate programs and so have 
separate Help support. In particular, the Help file for the main Turnpike program covers 
Turnpike's 'Off-line' facilities, while the one for Turnpike Connect covers the 'On-line' facilities. 
The FTP facilities of Turnpike Connect also have their own Help file because these are 
provided by a separate program.

At the end of the evaluation period
Your Evaluation copy of Turnpike can be used for 30 days, after which you won't be able to 
use the Connect part of the program to pick up or send any messages. The main Turnpike 
program will however continue to function for another 15 days - to let you continue working 
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with the information you have downloaded.

If you would like to continue using this software, you can upgrade to a full copy of the 
Demon Internet Suite which you can then install to work with all the mail, news, mailboxes, 
newsstands etc. that you've set up using the Evaluation version.  The full version gives you 
full licences for Turnpike, Internet Explorer plus SoftQuad's HotMeTaL Light v3 -- to help you 
make best use of your free 5MB of Demon Web space.

Demon users can buy the full software from Demon Internet for just £29.37 including VAT and
Delivery.  Just ring 0181 371 1234.  Or simply ask for the Demon Internet Suite Subscriber 
Edition from your local computer retailer.  The subscriber edition costs around £24.95+VAT 
(may be less at some outlets).

(Note: While you are waiting for the full copy to arrive, check the box at the bottom of the 
'Unregistered Evaluation Version' dialog shown when you sign on.)

Alternatively, if you don't want to continue using Turnpike, you can use the period after the 
Connect part of the program expires to export any mail that you have received or sent while 
you've been using Turnpike. Just select the messages you want to export eg. in a mail list of 
messages you've sent and received and then take the Export option from the File menu. This
will save these messages in a text file in Berkeley Unix Mailbox format which can be read by 
a range of Mail reader programs. (For further information, see the main program's Help file.)

You can then remove Turnpike from your system by running the 'Uninstall' program included 
in the Turnpike program group/folder.

Turnpike, November 1996
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